
Introduction
GrIP-Key makes games with lots of keyboard commands easier and more fun to play with your 
GamePad Pro.

The GrIPKey software allows you to assign keyboard commands to buttons on any GrIP-compatible 
game controller. You can save button definitions for up to 4 GrIP controllers in a control file called a 
keyset (or set) for each of your games.

While the GrIPKey software requires Windows¨ 95, you can use the completed GrIPKey sets (including 
all the included preconfigured sets) with DOS games as well.



Gravis GrIP
The Gravis Interface Protocol (GrIP) allows high-speed, two-way communication between your game 
and game controller through a standard PC game port. What does that mean? GrIP technology makes 
possible things such as automatic calibration, an unlimited number of controllers with an unlimited 
number of buttons and axes (6 degrees of freedom), force feedback, and more. 

Your GamePad Pro includes a built-in Y-cable that allows you to connect two GamePad Pro pads to 
your standard game port. The GamePad Pro’s GrIP capabilities allow each player to use as many as 10
independent buttons (depending on the number of buttons the game supports). Because of the basic 
limitations of the PC game port, standard joysticks and game pads support only 4 buttons’2 buttons per 
player in a two-player setup. With GamePad Pro, you and a friend get 10 buttons each.

If you own a Gravis MultiPort, and purchase adapters for your GamePad Pro pads, you can connect as 
many as 4 GamePad Pro pads at once (or any combination of GamePad Pro pads and standard GrIP-
Pads). In that case, each of four players can use up to 10 independent buttons. And the task of reading 
two GamePad Pro pads through the standard game port, or four GamePad Pro pads through a 
MultiPort, use 1_5% of the CPU cycle time (compared to 12-14% for a standard joystick or game pad), 
allowing your games to operate at full speed.

As developers have tried to add more players, dimensions, and special functions to their games, they 
have been limited by the capabilities of the standard PC game port. Console game developers who port 
their games over to the PC have had to strip multi-player, multi-button features from the games to make 
them playable on the PC. 

With the introduction of GrIP technology, all that has changed. GrIP allows developers to port arcade 
and console titles to the PC in their original format - not stripped down to accommodate the limitations of
the PC game port.

Gravis has worked hard to ensure that every major game developer in the world has the tools to 
incorporate GrIP support into their games, and we’ve made it very easy to do. Because of that, GrIP 
support is now included in many popular new action and fighting titles for DOS, and support for Gravis 
GrIP is built into Windows 95 DirectInput. 



GrIP Mode
Use GrIP Mode in Windows 95 and with any game that supports Gravis GrIP. This includes every 
Windows 95 DirectInputª game and a large selection of newer DOS games. 

Also use GrIP mode any time you use a GrIPKey control set for keyboard emulation (for keyboard-
controlled games).



Keyboard Emulation
With the GamePad Pro in GrIP Mode, you can use GrIPKey to assign keyboard commands to the 
GamePad’s buttons and directional pad. Any game that has a lot of keyboard commands will be more 
fun - and easier to play - with the GamePad Pro.

The GrIPKey software requires Windows 95 (you need this software to create your own game control 
“set” files), but you can use the included preconfigured game control sets - and any new sets you create
using GrIPKey - with any DOS or Windows 95 game by loading the GrIPKey set from the DOS 
command prompt using GKLOAD.

Enabling/Disabling Keyboard Emulation



Enabling/Disabling Keyboard Emulation
You can enable and disable Keyboard Emulation by clicking the Keyboard Emulation button on 
GrIPKey’s main toolbar or using the GrIP Control Center task bar utility (GCC), in Windows 95.



Starting GrIPKey
Double-click the GrIPKey icon.



Using GrIPKey
1.Finding the Game's Keyboard Commands 

2.Creating or Editing a GrIPKey Keyset 

3.Entering a Game  ’  s Keyboard Commands   

4.Assigning Game Commands to the GrIP Controller 

5.Configuring the GrIP Controller 

6.Printing a Reference Template 

7.Setting Up the Game for Keyboard Emulation 

8.Playing the Game 



1. Finding the Game's Keyboard Commands
Look in your game‘s setup or manual for the keyboard commands used in the game.



2. Creating or Editing a GrIPKey Keyset
Click the New button, or choose File–New to open a new Keyset window, where you can create and 
store a list of game commands.





3. Entering a Game's Keyboard Commands
To enter the game‘s keyboard commands:

1. Click the Add New Function button    in the Keyset window. The Function Configuration   window   
opens.

2. Type a description in the Function Description field.
3. Choose Normal or Step mode. 

If you selected Step, select Loop if you wish the keystroke string to repeat. (See example at left.) 
Select Auto Repeat if you wish a Normal keystroke string to repeat (for a turbo-fire effect).
4. Select the Keystroke tab. 



For a Normal mode entry, enter a key or series of keys in the Press String field. If you wish, you 
can enter a second key or series of keys in the Release String field to be performed when you release the
button.

For a Step mode entry, click the Add New Step String button    and enter a key or series of keys in
the Enter Step String dialog. Repeat these steps for each game command in the Step series.

To move a line up or down in the Step dialog, select the line and press the    “up” or “down” arrow
buttons.
1. Click OK, then repeat step 3 for each game command that you want to assign to a button on your 

GrIP controller.



4. Assigning Game Commands to the GrIP Controller
When all the game‘s commands are entered in the Keyset window, you can assign them to buttons on 
your GrIP controller:

Click the numbered Show Controller button for the port where a GrIP controller is connected (or choose 
View_Pad#). This opens a new window with an image of the controller.



Select a function from the Keyset window, and drag it over top of a button on the controller image.





5. Configuring the GrIP Controller
Select File/Configure GrIP to load the settings into your attached GrIP controllers.

Note: If you skip this step, keyboard emulation will not work. When you choose this option, Keyboard 
Emulation is automatically enabled and remains active until you disable it by clicking on the Keyboard 
Emulation button on the main toolbar or disable it in GCC.



6. Printing a Reference Template
If you wish, you can select File/Print or click on the printer icon to print a reference map of your GrIPKey
settings. 



7. Setting Up the Game for Keyboard Emulation
Start the game, and select Keyboard control in the game’s Setup.



8. Playing the Game
Put your keyboard aside and play the game! Use your printed reference template (if you printed one) to 
remind yourself of which functions you assigned to each button and each direction on the controller.



Changing a Button's Function
To edit a button, double-click on it to change the Function Configuration, or drag a new function from the 
Keyset window or from another button.

You can assign different button definitions to each GrIP controller.



The Main Toolbar

New - Open - Save - Cut - Copy    - Paste - Print - Keyboard - About - Help
                                                                                                                                                          Emulation On/Off 
 New
Click on the New tool to open a new, untitled GrIP control Keyset     window  .

 Open
Click on the Open tool to open an existing Keyset window.

 Save
Click on the Save tool to save the active Keyset.

 Cut
Allows you to move a function from one Keyset window to another. Select a function in the active 
Keyset window, then click on the Cut tool to copy the function to the Clipboard and remove it from the 
Keyset window. Use this command in conjunction with Paste.

Copy
Allows you to copy a function from one Keyset window to another. Select a function in the active 
Keyset window, then click on the Copy tool to copy the function to the Clipboard. Use this command in 
conjunction with Paste.

Paste
Click in the destination Keyset window, then click on the Paste tool to paste the function from the 
Clipboard.

 Print
Click on the Print tool to print a reference map of your button configurations.

 Keyboard Emulation On/Off

Click on this tool to turn keyboard emulation on and off. When you select Configure GrIP from the File 
menu, Keyboard Emulation goes on automatically. To disable it, click this tool; to turn keyboard 
emulation back on again, click this tool again.

If you prefer, you can also turn keyboard emulation on and off from the Windows 95 task bar using the 
GrIP Control Center. 

About

Click on the About icon to check the version number of your GrIPKey software.

Help

Click on the Help tool, then point with the Help pointer at a menu, tool, or window for context-sensitive 
Help.



The Keyset Window
The Keyset window allows you to develop a list of game functions and assign them to buttons on your 
GrIP controller. 

You can create or open as many Keysets as you like. You may wish to create separate Keysets with 
different commands for each controller.
Opening a New Keyset Window
Opening an Existing Keyset Window



Opening a New Keyset Window
To open a new Keyset window, click the New button on the main toolbar, or choose New from the File 
menu.



Opening an Existing Keyset Window
To open an existing Keyset window, click the Open button on the main toolbar or choose Open from the 
File menu, then select a Keyset file from the dialog.



The Function Configuration Window
You will do all your button programming in the Function Configuration window.

Opening the Function Configuration Window

The Description Tab

Function Description

Comments

Emulation Mode

Normal Mode

Step Mode

Loop

Auto-Repeat



Opening the Function Configuration Window
Choose Edit/Add Function..., or click on the Add New Function button in the active Keyset window. 

You can also open a Function Configuration window for a specific button by double-clicking on the 
button in the Controller     window   or by right-clicking on the button and selecting Properties.



The Description Tab



Function Description
Enter a descriptive label for the game command function in this field.



Comments
If you like, you can use this field to enter more descriptive comments about the game command in this 
field.



Emulation Mode

Select a mode for the function:



Normal Mode
Pressing a button configured with this function in Normal mode will have exactly the same effect in the 
game as pressing the keys on the keyboard. 



Step Mode
Step mode allows you to program a single button with a series of game commands (keystroke “Step 
strings”) that are always executed in the same order—or reverse order (for instance, cycling through a 
collection of weapons). 



Loop
The Loop option lets you cycle, or “loop” through a series of keystroke step strings. This example 
demonstrates the difference between the results of pressing a button configured in Step mode with and 
without Loop:

Function Configuration: Step string #1: A
Step string #2: B
Step string #3: C
Step string #4: D

Button Functions: Step with Loop: Step without Loop: 

1st button press A A
2nd button press B B
3rd button press C C
4th button press D D
5th button press A D
6th button press B D

...and so on.



Auto-Repeat
Auto-Repeat is a “turbo-fire” option that lets you set a keystroke string to repeat rapidly and 
continuously for as long as you continue to press the button. Auto-Repeat is not available with Step 
mode.



The Keystrokes Tab

Normal Mode Entries
Step Mode Entries



Normal Mode Entries:

Press String
Release String



Press String
In this field, you can enter a separate keystroke or keystrokes to be sent to the game when you press a 
button on the GrIP controller.



Release String
In this field, you can enter a separate keystroke or keystrokes to be sent to the game when you release 
a button.



Step Mode Entries:

Add New String - Delete String - Move Selected Step Down - Move Selected Step Up

Add New String
Click on this to open a New Step String window.

Delete String
Click on this to delete the currently selected Step string.

 Move Selected Step Up
Moves    the selected Step string up in the list.

Move Selected Step Down
Moves the selected Step string down in the list.

Editing a Step String



Editing a Step String
Double-click on the step string to open the editing window. Select the keystrokes that you want to 
change, then press Delete to delete them, or type new keys to replace them.



Controller Window
The Controller windows (labeled Keyset # – Slot #) correspond to the GrIP controllers attached to Ports 
1 and 2 of a standard PC game port or to Ports 1–4 of a GrIP MultiPort.

You can assign the functions in the Keyset window to the buttons and direction controls on your GrIP 
controller by dragging them from the Keyset window to this Controller window.
Opening a Controller Window
Editing a Button Configuration
Unmapping a Single Button

Unmapping All Buttons

Changing Controller Types



Opening a Controller Window
• Click the Controller# buttons in the Keyset window to display a programming window for the 

controller attached to that port.

• Choose a Pad# from the View menu.



Editing a Button Configuration
Double-click on a button in the Controller window (or right-click on it and select Properties) to open its 
Function Configuration window.



Unmapping a Single Button
Right-click on a button and select Unmap to unmap the function currently assigned to it. (This unmaps 
the function from the button but leaves the function definition intact in the KeySet window.)



Unmapping All Buttons
Right-click in an empty portion of the Controller window, then select Unmap All from the pop-up window 
to unmap all the functions from the buttons and direction controls in the active Controller window. 



Changing Controller Types
When you first open the Controller window, the software polls your game port or MultiPort to determine 
which type of controller you have connected. If you wish to change controller types, right-click in the 
Controller window, and select the controller type you prefer.



The Menus
File Menu

Edit Menu

View Menu

Options Menu

Window Menu

Help Menu



File Menu

New
Open
Close
Save
Save As
Print
Print Preview
Print Setup
Configure GrIP
Unload Keyset
Exit



New
Opens a new, untitled GrIP control set.



Open
Opens an existing set. Select a set file from the file dialog box.



Close
Closes the active set.



Save
Saves the active set.



Save As...
Saves a copy of the active set with a new name that you specify.



Print...
Prints a reference chart of your button configuration.



Print Preview
Allows you to view a preview of the reference chart on screen before you print.



Print Setup
Allows you to select print options.

The Properties button brings up a screen where you can select additional paper and printer options.



For image type selections, click the More Options... button.

For the fastest printing, and for printers with limited graphics support, a Line Art option is available. For a 
more realistic image, select one of the Dithering options.
If you like, you can also control the intensity/brightness of the printed image using the Intensity Control 
slider.
Select Letter- or Draft-quality output from the Printer Quality dropdown box.



Configure GrIP
Loads the settings in the active GrIPKey set into the GrIP driver. Once you have selected this option, the
GrIP controllers‘ buttons will function according to the GrIPKey set.



Unload Keyset
Clears the configuration of the GrIP controller.



Exit
Quits the program.



Edit Menu

Undo
Cut
Copy
Paste
Add Function
Delete Function



Undo
Undoes the last action.



Cut

Allows you to move a function from one Keyset window to another. Select a function in the active 
Keyset window, then select Cut to copy the function to the Clipboard and remove it from the Keyset 
window. Use this command in conjunction with Paste.



Copy
Allows you to copy a function from one Keyset window to another. Select a function in the active 
Keyset window, then select Copy to copy the function to the Clipboard. Use this command in conjunction
with Paste.



Paste
Use this menu option in conjunction with Cut or Copy. Click in the destination Keyset window, then 
select Paste to paste the function from the Clipboard.



Add Function
Opens a Function Configuration window that is not tied to a specific button.



Delete Function
Deletes the selected function from the Keyset window.



View Menu

Toolbar
Status Bar
Keystroke Viewer
Pads #1-4



Toolbar
Select this option to display the main toolbar on screen. 



Status Bar
Select this option to display the Status Bar at the bottom of the screen. By default, this is selected.



Keystroke Viewer
Select this option to open the Keystroke Viewer window to test your controller’s configuration. Then pick 
up your GrIP controller and press a button; you should see the keystrokes configured to that button in 
the Viewer window.



Pads #1-4
Select these options to display Controller programming windows for each of the connected 
controllers.



Options Menu

Preferences
Auto-Mapping



Preferences
Select Preferences to change the default controller type.



Auto Mapping
Auto-mapping saves you the “mouse-work” of dragging functions from the Keyset window to the 
Controller window. To use it:

1. Select Options/Auto Mapping.

2. Select the first function in the Keyset window list.

3. Pick up your GrIP controller, and press the button where you would like that function.

4. GrIPKey automatically selects the next function in the list. Press the button where you would like the
second function, and continue through the end of the Keyset list.



Window Menu
Use the options in the Window menu to select the window you want to be active and to arrange the open
windows on your screen.



Help Menu
Tip of the Day…

Help Topics

Go to Gravis Home Page

About GrIPKey



Tip of the Day...
Displays a tip.



Help Topics
Opens the GrIPKey Help file. Select a topic from the Contents list.



Go To Gravis Home Page
If you are connected to the Internet, selecting this option will open your Internet browser application and 
take you directly to the Advanced Gravis Home Page (www.gravis.com).



About GrIPKey...
If you ever need to contact Gravis for technical support, first select this option to check the version 
number of your GrIPKey software.



GKLOAD
GKLOAD is a DOS command-line utility for loading GrIPKey Keysets. While the GrIPKey software 
requires Windows 95, the GKLOAD utility allows you to configure your GamePad Pro with a GrIPKey set
from a DOS command prompt. That means that you can use your GrIP controller to play any keyboard-
controlled DOS game.

Note: GKLOAD does not work in a DOS box; it requires DOS v6.x or earlier or Windows 95 MS-
DOS Mode.

To load a GrIPKey set into your GamePad Pro using GKLOAD:
1. In DOS, change to your \GRAVIS\GRIP directory.

2. Type: GKLOAD [setname] <Enter>

(where “setname” is the name of a GrIPKey set)

When you return to Windows 95, GKLOAD disables keyboard emulation (returning your GamePad Pro 
to standard GrIP mode) and unloads itself from memory.



GrIP Control Center
The GrIP Control Center (GCC) is a Windows 95 task bar utility that allows you to check the status of 
your connected controllers and turn Keyboard Emulation on and off.

Starting GCC

Enabling/Disabling Keyboard Emulation

Automated Joystick Mode Switching



Starting GCC:
GCC is run automatically every time Windows 95 starts up. A small GCC icon appears on the task bar. 
To start the program, click on the task bar icon.

The GrIP Control Center window opens. 

The status window should display a message, letting you know what devices it finds attached to your 
game ports or MultiPort ports. If there is a problem with your mode selection, GCC will tell you, and 
the icon on the task bar will flash.



Enabling/Disabling Keyboard Emulation
The Keyboard Emulation on/off checkboxes allow you to disable and re-enable Keyboard Emulation 
from the task bar—without starting the GrIPKey software.

If you have not configured your GrIP controller with a GrIPKey set (which you do by choosing Configure 
GrIP from GrIPKey’s File menu or by using GKLOAD), these options will be unavailable.



Automated Joystick Mode Switching 
If GCC tells you to switch to GamePad Mode while your GamePad Pro is configured with a GrIPKey set,
or if your MultiPort switches into Emulation Mode while you are using a GrIPKey set, you should disable 
the Automated Joystick Mode Switching option in GCC.

This option is selected by default, and in most cases, you should leave it selected. When this option is 
enabled (selected), the GrIP driver will automatically put the GrIP MultiPort (if there is one attached) into 
GamePad Emulation mode when a game tries to access the joystick port directly. If a GamePad Pro is 
attached and this situation occurs, GCC will pop up a message, instructing you to switch the pad’s mode 
switch into GamePad Mode.
This option can occasionally cause problems when you are using a GrIPKey set to play a game in 
keyboard emulation. 



Troubleshooting
Nothing happens when I try to play a game. 

Mode-switching problems with GrIPKey

Buttons don  ’  t fire properly or at all.   



Nothing happens when I try to play a game.
• Make sure that the GamePad Pro is connected securely to Port A on your game card and that the 

game port is enabled. If you have two GamePad Pro pads, connect the second one to the built-in Y-
cable on the first pad.

If you have a GrIP MultiPort, follow the instructions in the MultiPort User’s Guide for connecting 
controllers.

• If you are using GrIPKey for keyboard emulation, put the pad in GrIP mode and make sure you have
chosen Configure GrIP from GrIPKey’s File menu or loaded a keyset using GKLOAD.

• See the User’s Guide for more troubleshooting help.



Mode Switching Problems with GrIPKey
If GCC tells you to switch to GamePad Mode while your GamePad Pro is configured with a GrIPKey set,
or if your MultiPort switches into Emulation Mode while you are using a GrIPKey set, you should disable 
the Automated Joystick Mode Switching option in GCC.

This option is selected by default, and in most cases, you should leave it selected. When this option is 
enabled (selected), the GrIP driver will automatically put the GrIP MultiPort (if there is one attached) into 
GamePad Emulation mode when a game tries to access the joystick port directly. If a GamePad Pro is 
attached and this situation occurs, GCC will pop up a message, instructing you to switch the pad’s mode
switch into GamePad Mode.

This option can occasionally cause problems when you are using a GrIPKey set to play a game in 
keyboard emulation. 



Buttons don't fire properly or at all.
• No matter how you have configured the buttons, you cannot press the Select and Start buttons at 

the same—if you try, the Start button will always take precedence.

• Make sure you have the buttons set up the way you want them to work:

- If you are using GrIPKey, make sure that you have selected Configure GrIP from the File menu. 
You can use the Keystroke Viewer (in GrIPKey’s View menu) to test the pad’s configuration.

• See the User’s Guide for more detailed troubleshooting help.




